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FEATURES 

Fully featured evaluation board for 10-lead precision ADCs 

Versatile analog signal conditioning circuitry 

On-board reference, reference buffers, and ADC drivers 

PC software for control and data analysis of time and 

frequency domain 

System demonstration platform-compatible (SDP-H1) 

EVALUATION BOARD KIT CONTENTS 

AD4000/AD4001/AD4002/AD4003/AD4020 evaluation board 

(see Table 7) 

12 V wall adapter power supply 

EQUIPMENT NEEDED 

PC running Windows 7 or Windows 10 

SDP-H1 board (EVAL-SDP-CH1Z) or FMC-compatible 

controller board 

Precision signal source 

Cable (SMA input to evaluation board) 

One end of cable is standard USB A and other end of cable is 

mini-B USB 

Band-pass filter suitable for 16-bit, 18-bit, and 20-bit testing 

(value based on signal frequency) 

AD40XX evaluation software 

GENERAL DESCRIPTION 

The AD4000/AD4001/AD4002/AD4003/AD4020 family of 

evaluation boards enable quick, simplified evaluation of the 

AD4000 family of 16-/18-/20-bit, precision successive approx-

imation register (SAR) analog-to-digital converters (ADCs). The 

AD4000/AD4001/AD4002/AD4003/AD4020 are low power, 

16-bit/18-bit/20-bit, precision SAR ADCs that offer high 

performance with throughputs up to 2 MSPS (1.8 MSPS for the 

AD4020). The evaluation board demonstrates the performance of 

the AD4000/AD4001/AD4002/AD4003/AD4020 family of 

ADCs and provides a simplified interface for a variety of system 

applications.  

The EVAL-AD4000FMCZ/EVAL-AD4001FMCZ/EVAL-

AD4002FMCZ/EVAL-AD4003FMCZ/EVAL-AD4020FMCZ 

evaluation boards, accessible from the EVAL-AD400x-FMCZ 

product page, (see Figure 1) are ideal for use with the Analog 

Devices, Inc., high speed system demonstration platform (SDP-

H1). These evaluation boards interface to the SDP-H1 board via 

a field-programmable gate array (FPGA) mezzanine card 

(FMC) low pin count (LPC) connector. 

On-board components include a high precision buffered band  

gap 5.0 V reference (ADR4550), a reference buffer (ADA4807-1), 

a common-mode buffer (ADA4807-1), a signal conditioning 

circuit with two op amps (ADA4807-1), and a power supply to 

derive the necessary voltage levels to supply all voltage needs. 

The EVAL-AD4000FMCZ, EVAL-AD4001FMCZ, EVAL-

AD4002FMCZ, EVAL-AD4003FMCZ, and EVAL-

AD4020FMCZ are populated with the AD4000, AD4001, 

AD4002, AD4003, and AD4020, respectively. However, these 

boards can be used to evaluate the performance of the AD4004, 

AD4005, AD4006, AD4007, AD4008, AD4010, AD4011, 

AD4021, and AD4022 by limiting the sample rate in the evaluation 

software to the maximum sample rate of the specific ADC. 

For example, the AD4000 on the EVAL-AD4000FMCZ can be 

used to evaluate the performance of the AD4004 if the sample 

rate is limited to 1 MSPS. See the data sheet of each product for 

the corresponding evaluation board. 

Full descriptions of these products are available in their 

respective data sheets, which must be consulted when using the 

corresponding evaluation board. Table 7 shows the models of 

the AD4000/AD4001/AD4002/AD4003/AD4020 evaluation 

boards. 
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EVALUATION BOARD PHOTOGRAPH 
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Figure 1. EVAL-AD400x-FMCZ 
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EVALUATION BOARD HARDWARE 
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Figure 2. Simplified Evaluation Board Block Diagram 

SETTING UP THE EVALUATION BOARD 

Figure 2 shows the simplified evaluation board block diagram. 

Figure 24 shows the evaluation board schematic. The board 

consists of the ADC, U1, with a reference, U6 (ADR4550), and 

ADC drivers, U12 and U14, the ADA4807-1 for the AD4001/ 

AD4002/AD4003/AD4020, and the ADA4805-1 for the 

AD4000 (see Table 6). The user also has an option to populate 

U2 with a low power, fully differential ADC driver, such as the 

ADA4940-1, when evaluating the AD4001/AD4003/AD4020. 

The evaluation board is a flexible design that enables the user to 

select components in addition to operating from an adjustable 

bench top power supply. 

Identifying the Evaluation Board 

A sticker label included on the bottom side (not pictured) of the 

EVAL-AD4000FMCZ/EVAL-AD4001FMCZ/EVAL-

AD4002FMCZ/EVAL-AD4003FMCZ/EVAL-AD4020FMCZ 

indicates evaluation board options. For example, the EVAL-

AD4020FMCZ evaluation board includes a sticker labeled 

EVAL-AD4020FMCZ.  

POWER SUPPLIES 

The system demonstration platform (SDP-H1) board supplies 

12 V to power the necessary rails for the EVAL-AD400x-FMCZ 

evaluation boards. 

The 7 V amplifier positive rail (+VS) is generated from U17 

(ADP7118). The −2.5 V negative amplifier rail (−VS) is 

generated by a combination of U3 (ADP2370), U7 (ADM660), 

and U21 (ADP7182). 

Each supply is decoupled where it enters the board and at each 

device. A single ground plane is used on this board to minimize 

the effect of high frequency noise interference.  

In addition, the board can be powered from a benchtop power 

supply. The screw terminals, J2 and J3, are provided for this 

function. When bench power is used, the on-board power 

supplies are no longer required. The solder links also must be 

changed as follows: SL1 = SL2 = SL5 = SL6 = SL7 = SL8 = SL9 = B. 

Table 1. Power Supplies Provided on the Board 

Power Supply (V) Function  Components Used 

5, 7 (Default)1 Positive rail ADP7118 

−5, −2.5 (Default)1 Negative rail ADP2370, ADM660, 
ADP7182 

1.8 ADC power ADP7118, ADP5300 

3.3 VDRIVE (digital power) ADP7118 

 
1 See Table 2. 

REFERENCE, REFERENCE BUFFER, AND COMMON-
MODE BUFFER 

An external 5 V reference (U6, ADR4550) is used by default to 

supply the ADCs directly. The user can also use one of the 2.5 V, 

3.3 V, and 4.096 V references by changing the on-board reference 

device U6 (ADR4525/ADR4533/ADR4540). There is an option to 

use a lower power reference, U22 (ADR3450). Note that the 

ADR3450 cannot accept input voltages beyond 5.5 V. The 

ADA4807-1 is used as a reference buffer (U16) and common-mode 

buffer (U18) by default. However, U16 can also be replaced by 

the AD8031 if required without compromising the 

performance. 
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SDP-H1 CONTROLLER BOARD 

The evaluation board uses a serial port interface (SPI) and is 

connected to the system demonstration platform (SDP-H1) 

controller board. The SDP-H1 board requires power from a 12 V 

wall adapter (included with the SDP-H1). The SDP-H1 has a 

Xilinx® Spartan 6 and an ADSP-BF527 processor with connectivity 

to the PC through a USB 2.0 high speed port. The SDP-H1 

allows the configuration and capture of data on the evaluation 

boards from the PC via USB. 

The SDP-H1 has an FMC LPC connector with full differential low 

voltage differential signaling (LVDS) and singled-ended low voltage 

complementary metal-oxide semiconductor (LVCMOS) support. 

The SDP-H1 also has a 120-pin connector that exposes the 

Blackfin® processor peripherals. This connector provides a 

configurable serial, parallel I2C and SPI, and general-purpose 

input/output (GPIO) communications lines to the attached 

daughter board. 

 

 

SOLDER LINKS 

The three solder link options on the evaluation board are 

configured depending on the generic of the ADC on the 

specific evaluation board, as described in Table 3. 

The evaluation board supports any amplifier mezzanine card 

(AMC). Insert this add on card on the 7-pin headers. Figure 3 

shows the AMC mounted on the evaluation board. The AMC 

ADC driver settings are required to use this option, described 

in Table 4. 
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Figure 3. AMC Installed on the EVAL-AD400x-FMCZ 

 

Table 2. Jumper Detail with Factory Default Setting 

Link Default Position Function Comments 

SL1 A +VS Change to Position B if using bench supplies 

SL2 A −VS Change to Position B if using bench supplies 

SL5 A +VS Change to Position B if using bench supplies 

SL6 A −VS Change to Position B if using bench supplies 

SL7 A VDD for ADC Change to Position B if using bench supplies 

LK2 A VREF Change to Position B if using the ADR3450 

LK51 B SDI Change to Position A if using connecting SDI to the VIO voltage (V_DRIVE)1 

JP1 B FSEL (U3) Change to Position A if selecting a 600 kHz switching frequency for the 
ADP2370 (U3) 

JP2 B ADC drivers Change to Position A if using the ADA4940-1 fully differential ADC 

JP3 B ADC drivers Change to Position A if using the ADA4940-1 fully differential ADC 

JP4 B ADC drivers Change to Position A if using the ADA4940-1 fully differential ADC 

JP5 B ADC drivers Change to Position A if using the ADA4940-1 fully differential ADC 

JP7 B V_DRIVE Change to Position A if using external 3.3 V for V_DRIVE (VIO voltage) 

JP8 B Stop (U20) Change to Position A if synchronizing ADP5300 (U20) STOP input with 
CNV_FMC from SDP-H1 connector 

1 Setting LK5 to Position A prevents access to the configuration register of the connected device and does not allow features including turbo mode, high-Z mode, and 
so on, to be enabled. 

Table 3. Jumpers Specific to 10-Lead Precision ADCs 

Link Default Position Configuration Generic 

SL4 A  Differential input AD4001, AD4003, AD4020 

SL4 B  Single-ended or pseudo differential AD4000, AD4002 
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Table 4. EVAL-AD400x-FMCZ Configuration Settings for Amplifier Mezzanine Card ADC Driver 

Component Default Position/Values Function Comments 

SL8 A −VS Change to Position B if using bench supplies for AMC power 

SL9 A +VS Change to Position B if using bench supplies for AMC power 

JP4, JP5 B ADC driver outputs Must be set to Position B to connect the ADC inputs to the AMC 
outputs 

R20, R40 0 Ω ADC driver outputs Must not be installed in order to disconnect the on-board ADC 
driver outputs (U12 and U14) 

R69, R95 0 Ω ADC driver inputs Must not be installed in order to disconnect the on-board ADC 
driver inputs (U12 and U14) 

R28, R35 590 Ω  Provides dc common-mode 
voltage to ADC driver inputs 

Must not be installed in order to disconnect the dc common-mode 
voltage from the on-board ADC driver inputs (U12 and U14) 

 

ANALOG INPUTS 

The analog inputs to the evaluation board are SMA connectors,  

J6 and J10. These inputs are buffered with dedicated amplifier 

circuitry (U12 and U14), as shown in Figure 26. The circuit 

allows different configurations, input range scaling, filtering, 

addition of a dc component, and use of different op amp and 

supplies. The analog input amplifiers are set as unity-gain 

buffers at the factory. 

The optional fully differential amplifier (FDA) can be used with the 

fully differential AD4000 devices on the EVAL-AD4001FMCZ, 

EVAL-AD4003FMCZ, and EVAL-AD4020FMCZ boards. Table 2 

lists the necessary jumper positions for using the FDA (U2). 

The AD4000 family devices require the inputs to be biased at 

midscale. The default configuration also sets both U12 and U14 

at midscale, generated from a buffered reference voltage divider 

(VCM). The noninverting inputs of both U12 and U14 are 

connected to the 590 Ω resistor dividers by default. These resistor 

dividers, R27, R28, R34, and R35, divide the reference voltage in 

half. The 590 Ω resistor dividers must be taken into account when 

interfacing with an external source via J6 and J10. The FDA 

(U2) outputs are biased to midscale with a 10 kΩ resistor 

divider (R65 and R67). 

The EVAL-AD400x-FMCZ evaluation boards are factory 

configured to provide the appropriate input signal type, single-

ended or fully differential, with the SL4 link. See Table 2 and 

Figure 26 for more information. 

To evaluate dynamic performance, a fast Fourier transform 

(FFT) test can be performed by applying a very low distortion 

ac source. 

For low frequency testing, the audio precision source (such as the 

SYS-2700 series) can be used directly because the outputs on these 

are isolated. Set the outputs for balanced and floating ground. 

Different precision sources can be used with additional filtering. 

https://www.analog.com/AD4000?doc=UG-1042.pdf
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GETTING STARTED 
The EVAL-AD400x-FMCZ evaluation boards can be controlled 

with the AD40XX Evaluation Software Installer. The following 

sections provide instructions for installing the supporting 

software and an overview for connecting the hardware to the PC. 

SOFTWARE INSTALLATION PROCEDURES 

The AD40XX Evaluation Software Installer installs the 

AD40XX Evaluation Software Installer and accompanying 

drivers for the SDP-H1 board. Install this software installer 

package before connecting the SDP-H1 board to the PC USB port 

to ensure that the SDP-H1 board is recognized when it connects 

to the PC. 

Installing the AD40XX Evaluation Software Installer 

To install the AD40XX Evaluation Software Installer, adhere to 

the following steps: 

1. Start the Windows® operating system and download the 

software from the EVAL-AD400x-FMCZ product page. 

2. Unzip the downloaded file. Run the setup.exe file. 

3. Begin installing the evaluation software by clicking the 

setup.exe file. The software installation window opens as 

shown in Figure 4. 
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Figure 4. AD40XX Evaluation Software Install Window 

4. Choose the installation directory and click Next. The default 

location is C:\Program Files (x86)\Analog Devices\. 
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Figure 5. Destination Directory Window 

5. Installing the AD40XX Evaluation Software Installer 

requires users to accept the license agreement shown in 

Figure 6. Read the agreement before clicking Next to 

proceed. 
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Figure 6. License Agreement Window 
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6. The window shown in Figure 7 provides a summary of the 

software installation. Click Next to install the software 

listed in the window. 
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Figure 7. Start Installation Window 

7. A pop-up window opens and displays a bar showing the 

installation progress, as shown in Figure 8. 
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Figure 8. Overall Progress 

8. Click Next to complete the installation and launch the 

SDP-H1 driver installation, as shown in Figure 9. 
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Figure 9. Installation Complete Window 

Installing the SDP-H1 Board Drivers 

The AD40XX Evaluation Software Installer uses the ADI SDP 

drivers (Version 2.3.0.207) to interface with the SDP-H1 controller 

board. Following the successful software installation, the installer 

automatically begins installing the ADI SDP drivers (indicated by 

the pop-up shown in Figure 10). 
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Figure 10. SDP-H1 Driver Installation 

1. The ADI SDP Drivers 2.3.0.207 Setup wizard opens the 

window, as shown in Figure 11. Click Next to install the 

SDP-H1 drivers. 

1
4

9
8

1
-1

1
1

 

Figure 11. ADI SDP Drivers 2.3.0.207 Setup Window 

2. Installing the ADI SDP Drivers 2.3.0.207 requires the user 

to accept the license agreement that appears in Figure 12. 

Read the agreement before clicking I Agree to proceed. 
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Figure 12. ADI SDP Drivers (v2.3.0.207) License Agreement Window 
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3. Choose the destination folder for the ADI SDP drivers and 

click Install. The default folder is shown in Figure 13. 
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Figure 13. Choose Install Location 

4. The installation begins, and a progress bar shown in Figure 14 

is displayed. 
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Figure 14. Installing 

5. Click the Close button shown in Figure 15 when the 

installation is complete. 
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Figure 15. Installation Complete 

When plugging in the SDP-H1 board via the provided USB cable, 

allow the Found New Hardware Wizard to run. Check that the 

drivers are installed and the SDP-H1 board are connected properly 

by checking the Device Manager of the PC. If the drivers and 

board are connected, Analog Devices System Development 

Platform (32MB) appears under ADI Development Tools (see 

Figure 16). 

1
4

9
8

1
-0

1
3

 

Figure 16. Device Manager Menu 
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Uninstalling the Software 

To uninstall the AD40XX Evaluation Software Installer, take the 

following steps: 

1. Launch the uninstall wizard by navigating to Start > 

Control Panel > Programs and Features > AD40XX 

Customer Evaluation Software to open a window with the 

Uninstall button. 

2. Click Yes in the confirmation window that appears. 

To uninstall the SDP drivers, adhere to the following steps: 

1. Launch the uninstall wizard by navigating to Start > 

Control Panel > Programs and Features > ADI SDP 

Drivers 2.3.0.207 to open a window with the Uninstall 

button. 

2. Click Yes in the confirmation window that appears. 

EVALUATION HARDWARE SETUP PROCEDURES 

The EVAL-AD400x-FMCZ evaluation boards connect to the 

SDP-H1 via the FMC connector (J5). The SDP-H1 is the 

controller board and functions as the communication link between 

the PC and connected EVAL-AD400x-FMCZ evaluation board. 

Connecting the Evaluation Hardware to a PC 

To connect the EVAL-AD400x-FMCZ evaluation board and 

SDP-H1 board to a PC: 

1. Before connecting power, connect the FMC connector of 

the EVAL-AD400x-FMCZ evaluation board (J5) to the 

FMC connector on the SDP-H1 board (J4). 

2. Power the SDP-H1 with the appropriate supply, as 

described in the Power Supplies section. 

3. Connect the SDP-H1 to the PC with the USB cable. 

Verifying Hardware Connection 

To verify the AD4000 family evaluation board is properly 

connected to the PC, take the following steps: 

1. Allow the Found New Hardware Wizard to finish running 

after the SDP-H1 board is connected to the PC via the USB 

cable. Choose the automatically search for the appropriate 

drivers option for the SDP drivers if prompted. 

2. Verify the hardware to PC connection by navigating to the 

Device Manager via the Control Panel. If the hardware is 

properly connected, Analog Devices SDP-H1 appears 

under ADI Development Tools. 
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SOFTWARE OPERATION 
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Figure 17. AD40XX Evaluation Software Front Panel (Configure Tab View) 

RUNNING THE EVALUATION SOFTWARE 

After installing the AD40XX Evaluation Software Installer (see 

the Software Installation Procedures section), run the software 

with either of the following methods: 

• Navigate to the destination folder of the AD40XX 

Evaluation Software Installer selected during the 

installation procedure and run the EVAL-AD40xx.exe file. 

• Click Start > All Programs > Analog Devices > AD40XX 

Evaluation Software > AD40xx Evaluation Software. 

ESTABLISHING HARDWARE CONNECTION 

After the AD40XX Evaluation Software Installer initializes, the 

software front panel appears, and the software automatically 

connects to any EVAL-AD400x-FMCZ evaluation board 

connected to the PC. The detected evaluation board is displayed 

in the Eval Board Connected indicator on the front panel (see 

Label 7 in Figure 17). 

If the software does not detect a valid EVAL-AD400x-FMCZ 

evaluation board, a connectivity error dialog box appears (see 

Figure 18). Clicking the Rescan button instructs the software to 

try to detect the hardware again. Clicking the Offline Mode 

button causes the software to boot in offline mode. See the 

Saving and Loading Sessions section for the functions provided 

in offline mode. 
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Figure 18. Connectivity Error Dialog Box 

OVERVIEW OF THE FRONT PANEL 

The AD40XX Evaluation Software Installer front panel is 

shown in Figure 17. The following sections describe the various 

software controls accessible on the front panel. 

File Menu 

The File menu (Label 1 in Figure 17) provides the following 

options: 

• Save Captured Data (Ctrl + S): saves the current AD40XX 

Evaluation Software Installer session in a .csv file. The user 

is prompted to either choose or enter the path of the file in 

the Save As dialog box. This saved file can be loaded by the 

software at a future time to display previously captured data. 

https://www.analog.com/EVAL-AD400x-FMCZ?doc=UG-1042.pdf
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• Load Captured Data (Ctrl + O): opens the Load File dialog 

box and the user is prompted to load the previously saved 

evaluation software session files (.csv). 

• Take Screenshot: saves the current front panel display as 

an image file (.jpg). The user is prompted to either choose 

or enter the path of the file in a Save As dialog box. 

• Print Screenshot: sends a screenshot of the current front 

panel display directly to the default printer identified by 

the operating system for printing. 

• Exit: closes the AD40XX Evaluation Software Installer 

front panel and exits the software. 

Edit Menu 

The Edit (Label 1 in Figure 17) menu provides the following 

option: 

• Reinitialize Default Values: resets a subset of the 

AD40XX Evaluation Software Installer front panel controls 

to the default state. 

Help Menu 

The Help menu (Label 1 in Figure 17) provides the following 

options: 

• Analog Devices Website: opens the Analog Devices webpage 

(www.analog.com) in the default browser of the PC. 

• AD4000 Evaluation Hardware Info: opens the AD4000 

family evaluation board EVAL-AD400x-FMCZ product 

page in the default browser of the PC. 

• Context Help (Ctrl + H): displays a context help dialog 

box, which displays information about the various software 

controls when the mouse hovers over them. 

• About (Ctrl + A): displays version and copyright information 

of the AD40XX Evaluation Software Installer in a dialog box. 

Display Tabs 

The following five tabs are located at the top of the front panel 

(Label 2 in Figure 17): Configure, Waveform, Histogram, FFT, 

and Summary. These tabs select various front panel views. 

Single Capture Button 

Click Single Capture (Label 3 in Figure 17) to perform a single 

set of conversions. The number of conversions performed is set 

with the Samples dropdown list, which is located to the left of 

the Single Capture control. 

Continuous Capture Button 

Click Continuous Capture (Label 4 in Figure 17) to perform 

repeated sets of conversions. The number of conversions 

performed per set is set with the Samples dropdown list. 

Samples Dropdown List 

The Samples dropdown list (Label 5 in Figure 17) sets the 

number of conversions that are performed when Single Capture is 

clicked. The button also sets the number of conversions per set 

when Continuous Capture is clicked. 

Status Bar 

The status bar (Label 6 in Figure 17) displays information about 

the current process being completed by the AD40XX Evaluation 

Software Installer. The Status Bar includes a Busy indicator, which 

displays if the software is busy performing a task such as 

performing conversions, analyzing results, and so on. 

CONFIGURE TAB 

Figure 17 shows the Configure tab view. The Configure tab 

provides controls for configuring the connected AD4000 family 

device and software settings. The Configure tab view contains 

the following controls and indicators:  

• Eval Board Connected (Label 7 in Figure 17): indicates that 

the EVAL-AD400x-FMCZ board is connected to the software. 

• Reference Voltage (VREF) (Label 8 in Figure 17): sets the 

VREF used in data analysis such as when calculating LSB 

Size (see Label 2 in Figure 19), or measured voltage in the 

waveform graph (see the Waveform Tab View section. This 

control must be set to match the VREF used on the 

connected AD4000 family evaluation board. 

• Oversampling Ratio (Label 9 in Figure 17): sets the 

oversampling ratio applied to the captured data. After this 

control is set to any value other than None, the software 

sums up the consecutive conversion results together to 

increase effective resolution. The number of conversions 

summed together is set by the Oversampling Ratio control. 

• Throughput (kSPS) (Label 10 in Figure 17): sets the 

throughput of the connected AD4000 family device. The 

maximum value of this control is automatically set to reflect 

the maximum achievable throughput of the connected 

device, given the state of the Status Bits and Turbo Mode 

controls. See the relevant AD4000 family device data sheet 

for more information on maximum achievable throughput. 

• Device Config Settings (Label 11 in Figure 17): configures 

the connected AD4000 family device user configuration 

register settings. See the relevant AD4000 family device data 

sheet for a detailed description of the user configuration 

register and the device features. 

• Status Bits: enables or disables the status bits for the 

connected device. 

• Span Compression: enables or disables span 

compression for the connected device. 

• High-Z Mode: enables or disables high-Z mode.  

• Turbo Mode: enables or disables turbo mode for the 

connected device. 

• Read Register (Label 12 in Figure 17): reads the AD4000 

family device user register. When Read Register is clicked, 

the contents of the connected AD4000 family device register 

are read to update the Device Config Settings items 

accordingly. 

• Device configuration settings display (Label 13 in 

Figure 17): displays the status of the user register when 

Read Register is clicked. Each of the following indicators 

displays the state of the corresponding settings:  
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• Status Bits, Span Compression, High-Z Mode, and

Turbo Mode status indicators indicate whether the

corresponding AD4000 family device are reported as

enabled or disabled in the user configuration register

of the connected AD4000 family device.

• Overvoltage Clamp Flag: indicates the status of the OV 

clamp flag in the user configuration register of the

connected device. When this indicator is red, the OV flag 

is low, indicating the presence of an overvoltage event. 

• Status Bits Indicators (Label 14 in Figure 17): displays the

configuration settings of the device as indicated by the

status bits. The status bits are enabled with the Status Bits

control in the Device Config Settings pane (Label 11 in

Figure 17). The Status Bits Indicators are only updated

after conversions are performed with the Single Capture

or Continuous Capture controls when the status bits are

enabled on the connected AD4000 family device. The

status bit functionality is described in the relevant AD4000 

family device data sheet.  

• The Span Compression, High-Z Mode, and Turbo

Mode status indicators indicate whether features of 

the corresponding AD4000 family device is reported 

as enabled or disabled by the status bits of the 

connected AD4000 family device. 

• Overvoltage Clamp Flag: displays whether the OV

clamp flag in the status bits indicated an overvoltage 

event in any of the conversions in the most recently 

displayed results. When this indicator is red, the OV 

flag is low, indicating the presence of an overvoltage 

event. See the AD4000 family data sheets for more 

details on the OV clamp flag.  
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WAVEFORM TAB VIEW 
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Figure 19. Waveform Tab View 

Figure 19 shows the Waveform tab view. The Waveform tab 

view shows the time domain representation of the conversion 

results from the connected AD4000 family device, as well as 

several analysis items. The Waveform tab view contains the 

following controls and indicators: 

• Waveform graph (Label 1 in Figure 19): displays the time 

domain plot of the most recently captured or loaded 

conversion results. The scale and range of the waveform 

graph can be set in the Waveform Analysis box by double 

clicking on the Minimum Value and Maximum Value 

fields and entering the desired values. The waveform graph 

also includes viewing tools that are described in Table 5. 

• Waveform Analysis (Label 2 in Figure 19): shows the 

following analysis items for the currently displayed data. 

• Number of Samples: displays the number of captured 

samples in the data displayed in the waveform graph. 

The displayed value factors in the oversampling ratio 

that is set with the OSR control. 

• Pk-Pk Amplitude: displays the peak-to-peak 

amplitude of the captured data (the difference 

between the Maximum Value and the Minimum 

Value). 

• Maximum Value: displays the maximum value 

measured in the captured data. 

• Minimum Value: displays the minimum value 

measured in the captured data. 

• OSR: displays the oversampling ratio applied to the 

captured data. The OSR can be changed using the 

Oversampling Ratio control in the Configure tab view. 

• LSB Size: displays the effective size (in μV) of each 

LSB given the resolution of the connected AD4000 

family device, the Reference Voltage (VREF), and the 

Oversampling Ratio values selected in the Configure 

tab view. 

• Mean: displays the arithmetic mean of the captured data. 

• Standard Deviation: displays the standard deviation 

of the captured data. 

• Graph Configuration pane (Label 3 in Figure 19): sets the 

following waveform graph axis properties. 

• X units: sets the x-axis units of the waveform graph. 

The x-axis units can be either set to samples or seconds. 

The time step size, when Seconds is selected, is calculated 

from the selected Throughput and Oversampling 

Ratio controls in the Configure tab view. 

• Y units: sets the y-axis units of the waveform graph. 

The y-axis units can be either set to codes or volts. 

The voltage values, displayed when Volts is selected, is 

calculated from the LSB Size in the Waveform 

Analysis items. 

• X-axis: autoscale: sets whether the x-axis range of the 

waveform graph autoscales as new data is plotted or 

remains at a fixed scale. 

• Y-axis: autoscale: sets whether the y-axis range of the 

waveform graph autoscales or remains at a fixed scale 

as new data is plotted. 
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HISTOGRAM TAB VIEW 
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Figure 20. Histogram Tab View 

Figure 20 shows the Histogram tab view. The Histogram tab is 

useful for performing statistical analysis of the AD4000 family 

device conversion results, especially when measuring dc signals. 

The histogram graph shows the distribution of the conversion 

results as well as various statistical analysis items. The Histogram 

tab contains the following controls and indicators: 

• Histogram graph (Label 1 in Figure 20): displays histogram of 

the most recently captured or loaded conversion results. 

The scale and range of the histogram graph can be set by 

double-clicking on the minimum and maximum axis 

values and entering the desired values. The histogram 

graph also includes viewing tools, described in Table 5. 

• Histogram Analysis (Label 2 in Figure 20): shows the 

following analysis items for the currently displayed data. 

• Number of Samples: displays the number of captured 

samples in the data displayed in the histogram graph. 

The displayed value factors in the oversampling ratio 

shown in the OSR indicator. 

 

• Pk-Pk Amplitude: displays the peak-to-peak 

amplitude of the captured data (the difference between 

the Maximum Value and the Minimum Value). 

• Maximum Value: displays the maximum value 

measured in the captured data. 

• Minimum Value: displays the minimum value 

measured in the captured data. 

• OSR: displays the oversampling ratio applied to the 

captured data. The OSR can be changed using the 

Oversampling Ratio control in the Configure tab view. 

• LSB Size: displays the effective size (in μV) of each LSB 

given the resolution of the connected AD4000 family 

device, and the Reference Voltage (VREF) and 

Oversampling Ratio values selected in the Configure tab. 

• Mean: displays the arithmetic mean of the captured data. 

• Standard Deviation: displays the standard deviation 

of the captured data. 
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Figure 21. FFT Tab View 

Figure 21 shows the FFT tab view. The FFT tab displays the 

calculated FFT representation of the conversions results from the 

connected AD4000 family device and common ac performance 

metrics. The FFT tab contains the following controls and 

indicators: 

• FFT graph (Label 1 in Figure 21): displays an FFT of the 

most recently captured or loaded conversion results. Set 

the scale and range of the FFT graph by double clicking on 

the minimum and maximum values along the x-axis and y-

axis and entering the desired values. The FFT graph also 

includes viewing tools that described in Table 5. 

• FFT Analysis (Label 2 in Figure 21): displays common ac 

performance metrics of the captured data. Results are 

calculated from the FFT spectrum, typically ignoring the 

first six frequency bins. 

• Throughput: displays the effective throughput (sample 

rate) of the captured data. The displayed value factors in 

the oversampling ratio displayed in the OSR indicator. 

• Bin Width: displays the size of the frequency bins in the 

FFT graph x-axis. The bin width is a function of both the 

Throughput (kSPS) control (Label 10 in Figure 17) and 

the number of samples in the captured data. 

• OSR: displays the oversampling ratio applied to the 

captured data. The OSR can be changed using the 

Oversampling Ratio control in the Configure tab. 

• LSB Size: displays the effective size (in μV) of each 

LSB. The LSB size is a function of the resolution of the 

connected AD4000 family device, the Reference 

Voltage (VREF), and the Oversampling Ratio values 

selected in the Configure tab view. 

• Dynamic Range: displays the calculated dynamic range. 

• SNR: displays the calculated signal-to-noise ratio (SNR). 

• THD: displays calculated total harmonic distortion 

(THD), up to the fifth harmonic. 

• SINAD: displays the calculated single-to-noise and 

distortion ratio (SINAD). 

• SFDR: displays the calculated spurious-free dynamic 

range (SFDR). 

• Fund. Frequency: displays the frequency identified as 

fundamental, the frequency bin with the largest signal. 

• Fund. Amplitude: displays amplitude of the fundamental 

frequency, the frequency bin with the largest signal. 

• RMS Noise: displays the measured rms voltage noise. 

• Avg. Noise Floor: displays the average amplitude of noise 

frequency bins, more specifically, bins not identified as 

fundamental or harmonic. 

• Show Harmonic Content: contains Frequency and 

Amplitude information for the fundamental and harmonic 

tones identified in the FFT. These displays are only visible 

when toggled by the Show Harmonic Content control and 

are not displayed in Figure 21. 

• Frequency: frequency bins identified as fundamental and 

harmonic. 

• Amplitude: amplitude of the fundamental and harmonic 

frequencies. 

• Graph Configuration: sets the following FFT graph axis 

properties. 

• X-axis: autoscale: sets whether the FFT graph x-axis range 

autoscales as new data is plotted or remains at a fixed scale. 

• Y-axis: autoscale: sets whether the FFT graph y-axis range 

autoscales as new data is plotted or remains at a fixed 

scale. 

• X-axis scale: sets whether the FFT graph x-axis scaling 

is linear or logarithmic. 

https://www.analog.com/AD4000?doc=UG-1042.pdf
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Figure 22. AD40XX Evaluation Software Summary Tab View 

Figure 22 shows the Summary tab view. The Summary tab 

simultaneously displays the waveform, histogram, and FFT 

graphs and analysis for the AD4000 family device conversion 

results on the screen. The Summary tab contains the following 

controls and indicators: 

• Waveform graph (Label 1 in Figure 22): displays the time 

domain plot of the most recently captured or loaded 

conversion results. The scale and range of the waveform 

graph can be set by double-clicking on the minimum and 

maximum axis values along the x-axis and y-axis and 

entering the desired values. The waveform graph also 

includes viewing tools that are described in Table 5. 

• Histogram graph (Label 2 in Figure 22): displays the 

histogram of the most recently captured or loaded conversion 

results. The scale and range of the histogram graph can be 

set by double-clicking on the minimum and maximum 

values along the x-axis and y-axis and entering the desired 

values. The histogram graph also includes viewing tools 

that are described in Table 5. 

• FFT graph (Label 3 in Figure 22): displays an FFT of the 

most recently captured or loaded conversion results. The 

scale and range of the FFT graph can be set by double 

clicking on the minimum and maximum axis values and 

entering the desired values. The FFT graph also includes 

viewing tools that are described in Table 5. 

• Analysis Summary (Label 4 in Figure 22): shows the 

following analysis items for the currently displayed data. 

• Pk-Pk Amp: displays the peak-to-peak amplitude of 

the captured data. 

• Mean: displays the arithmetic mean of the captured data. 

• Standard Deviation: displays the standard deviation 

of the captured data. 

• Fund. Freq.: displays frequency identified as the 

fundamental (the frequency bin with the largest signal). 

• Fund. Amp.: displays the amplitude of the Fund. Freq. 

• RMS Noise: displays the measured rms voltage noise 

of the captured data. 

• LSB Size: displays the effective size (in μV) of each 

LSB. The LSB size is a function of the resolution of the 

connected AD4000 family device, the Reference 

Voltage (VREF), and Oversampling Ratio values 

selected in the Configure tab. 

• Dynamic Range: displays the calculated dynamic 

range of the captured data. 

• SNR: displays the calculated SNR of the captured data. 

• THD: displays the calculated THD of the captured 

data (up to the fifth harmonic). 

• SINAD: displays the calculated SINAD of the 

captured data. 

• SFDR: displays the calculated SFDR of the captured data. 

https://www.analog.com/AD4000?doc=UG-1042.pdf
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GRAPH VIEWING CONTROLS 

The tools described in Table 5 allow users to control the 

different chart displays within any of the chart panels in the 

graphical user interface (GUI) tabs. 

Table 5. GUI Tools 

Symbol Description 

 This tool controls the cursor, if present. 

 This tool zooms in and out of the data on the 
graph. 

 This tool is used for panning. 

SAVING AND LOADING SESSIONS 

The AD40XX Evaluation Software Installer allow users to save 

and load data to quickly recall previous results. 

Clicking File > Save Captured Data or using the shortcut  

Ctrl + S saves the capture data and relevant sampling parameters 

for the currently displayed AD4000 family device in a .csv file. 

These saved files can be loaded at a later time by clicking  

File > Load Captured Data or using the shortcut Ctrl + O. 

Upon loading these .csv files, the evaluation software displays 

the data in the Waveform, Histogram, FFT, and Summary tabs. 

The evaluation software also allows the user to export the raw 

data of any of the graphs into a generic text file by right clicking 

them and selecting Export > Export Data to Excel, as shown in 

Figure 23. The exported data can be used for additional 

postprocessing, but the generated text file cannot be loaded back 

into the AD40XX Evaluation Software Installer. 
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Figure 23. Export Raw Data 

OFFLINE MODE 

The AD40XX Evaluation Software Installer can be operated 

without an accompanying EVAL-AD400x-FMCZ evaluation 

board. If no EVAL-AD400x-FMCZ evaluation board is detected 

when the software initializes, the dialog box in Figure 18 is 

displayed. Clicking Offline Mode causes the evaluation 

software to boot in offline mode. 

In offline mode, new conversion results cannot be captured, but 

previously saved AD40XX Evaluation Software Installer 

sessions can be loaded to view previously captured data. See the 

Saving and Loading Sessions section for instructions on loading 

previously saved data. 

https://www.analog.com/EVAL-AD400x-FMCZ?doc=UG-1042.pdf
https://www.analog.com/AD4000?doc=UG-1042.pdf
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TROUBLESHOOTING 
SOFTWARE 

To troubleshoot the software, take the following steps: 

1. Always install the software before connecting the hardware to 

the PC. 

2. Always allow the install to fully complete (the software is a 

two-part installation, the ADC evaluation software and the 

SDP-H1 drivers). A restart is recommended after installation 

is finished. 

3. When the user first plugs in the SDP-H1 board via the 

provided USB cable, allow the Found New Hardware 

Wizard to run, which can take several seconds. However, 

allow this to happen before starting the software. 

4. If the EVAL-AD400x-FMCZ evaluation boards or SDP-H1 

board are connected to the PC via the USB port but are not 

being detected by the AD40XX Evaluation Software 

Installer, ensure that the board is being recognized in the 

Device Manager, as shown in Figure 16. 

5. If connected to a slower USB port where the SDP-H1 cannot 

read as quickly as it needs to, a timeout error can result. In 

this case, it is advised not to read continuously, or 

alternatively, to lower the number of samples taken. 

HARDWARE 

To troubleshoot the hardware, take the following steps: 

1. If the software does not read back any data, do the following: 

a. Check that the power is applied within the power 

ranges described in the Power Supplies section. 

b. Using a voltmeter, measure the voltage present at each 

of the test points: +VS, −VS, 1P8V_VDD, VDD_1P8V, 

+3P3V, +5V, and REF1, and common-mode voltages 

(REF/2) at IN+ and IN− to ensure that they are accurate. 

The SDP-H1 board LED1 must be illuminated. 

c. Launch the software and read the data. If nothing 

happens, exit the software. 

d. Power down the board and relaunch the software. 

e. If no data is read back, confirm that the ADC evaluation 

board is connected to the SDP-H1 board and that the 

board is being recognized in the Device Manager, as 

shown in Figure 16. 

2. When the user is working with the software in standalone/ 

offline mode (no hardware connected) and later chooses to 

connect hardware, close and relaunch the software. 

 

 

https://www.analog.com/SDP-H1?doc=UG-1042.pdf
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EVALUATION BOARD SCHEMATICS AND ARTWORK 
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Figure 24. EVAL-AD400x-FMCZ, Power Supplies 

 

https://www.analog.com/EVAL-AD400x-FMCZ?doc=UG-1042.pdf
https://www.analog.com/AD4000?doc=UG-1042.pdf


UG-1042 Easy to Use AD4000 Series 16-/18-/20-Bit Precision SAR ADCs User Guide 
 

Rev. I | Page 22 of 30 

14981-024

 

Figure 25. EVAL-AD400x-FMCZ, Voltage Reference, Common-Mode and Reference Buffers 
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Figure 26. EVAL-AD400x-FMCZ, ADC Drivers, and ADC 
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Figure 27. EVAL-AD400x-FMCZ, EVAL-SDP-CH1Z Connector 
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Figure 28. EVAL-AD400x-FMCZ Silkscreen, Top Layer 
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Figure 29. EVAL-AD400x-FMCZ, Layer 1  
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Figure 30. EVAL-AD400x-FMCZ, Layer 2 
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Figure 31. EVAL-AD400x-FMCZ, Layer 3  
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Figure 32. EVAL-AD400x-FMCZ, Layer 4 
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ORDERING INFORMATION 
EVALUATION BOARD BILL OF MATERIALS 

Table 6. Bill of Materials 

Reference Designator Description Manufacturer Part Number Stock Code 

U1 16-/18-bit, 2 MSPS or 20-bit, 1.8 MSPS 
precision SAR ADC in 10-lead mini small 
outline package (MSOP) 

Analog Devices See Table 7 See Table 7 

U2 Ultralow power, low distortion ADC 
driver, 4 nV/√Hz 

Analog Devices ADA4940-1 Do not place 

U3 High voltage, 1.2 MHz/600 kHz, 800 mA, 
low quiescent current buck regulator 

Analog Devices ADP2370 ADP2370ACPZ-5.0-R7 

U4 Linear regulator, 3.3 V, ultralow noise, 
complementary metal–oxide 
semiconductor (CMOS) 

Analog Devices ADP7118 ADP7118AUJZ-3.3-R7 

U6 Ultralow noise, high accuracy voltage 
reference 

Analog Devices ADR4550 ADR4550BRZ 

U7 CMOS, switched capacitor voltage 
converter 

Analog Devices ADM660 ADM660ARZ 

U8 IC EEPROM, 2 kb, 400 kHz, 8-lead small 
outline integrated circuit (SOIC) 

ST M24C02-WMN6TP Digi-Key 497-8552-1-ND 

U12, U14 (only for 
AD4001/AD4002/ 
AD4003/AD4020) 

Low noise, high speed amplifier Analog Devices ADA4807-1 ADA4807-1ARJZ 

U12, U14 (only for AD4000) Low noise, high speed amplifier Analog Devices ADA4805-1 ADA4805-1ARJZ 

U16, U18 Low noise, high speed amplifier Analog Devices ADA4807-1 ADA4807-1ARJZ 

U17 Linear regulator, 3.3 V, ultralow noise, 
CMOS 

Analog Devices ADP7118 ADP7118AUJZ-3.3-R7 

U19 Linear regulator, 1.8 V, ultralow noise, 
CMOS 

Analog Devices ADP7118 ADP7118AUJZ-1.8-R7 

U20 Ultralow power step-down regulator Analog Devices ADP5300 ADP5300ACPZ-1-R7 

U21 –28 V, −200 mA, low noise, linear 
regulator 

Analog Devices ADP7182 ADP7182AUJ-2.5-R7 

U22 Micropower, high accuracy, 5 V voltage 
reference 

Analog Devices ADR3450 ADR3450ARJZ-R2 

C1, C2, C5, C9, C61 10 µF, 20 V tantalum capacitor AVX TAJB106K020RNJ FEC 197427 

C3, C4, C16, C17, C21, C26 2.2 µF, X7R, 16 V, 0805 capacitor, 
multilayer ceramic capacitor (MLCC) 

Murata GRM21BR71C225KA12L FEC 1828829 

C6 4.7 µF, 16 V, X7R, 0805 ceramic capacitor Taiyo Yuden EMK212B7475KG-T FEC 1853520 

C7, C10, C12, C18, C40, C68, 
C73, C74, C75, C76, C77 

10 µF, 16 V, 0805 capacitor Murata GRM219R61C106KA73D FEC 1845747 

C8, C57, C64, C69, C71 1 µF, X7R, 50 V, 0805 capacitor Murata GRM21BR71H105KA12L FEC 1735541 

C14, C15 100 nF, X7R, 25 V, 0805 capacitor Murata LLL216R71E104MA01L FEC 1294646 

C24, C30, C37, C41, C42, C44, 
C45, C48, C54, C60, C66, C67, 
C70 

0.1 µF, X7R, 50 V ceramic capacitor Murata GRM188R71H104KA93D FEC 8820023 

C35, C52 180 pF, 50 V, 0603, C0G/NP0 capacitor YAGEO 
(Phycomp) 

CC0603JRNPO9BN181 FEC 3019494 

C11, C13, C19, C20, C25, C29, 
C32, C36, C38, C39, C43, C46, 
C47, C49, C50, C51, C55, C63, 
C72 

SMD capacitor Not applicable Not applicable Do not place 

C56 10 µF, X5R, 25 V, 0805, MLCC capacitor Murata GRM219R61E106KA12D FEC 2426961 

C58, C65 2.2 µF, 50 V, 0805, X7R capacitor TDK C2012X7R1H225K125AC FEC 2346945 

C186 SMD capacitor EPCOS B37921C9104K60 Digi-Key 495-3265-1-ND 

L1 1000 Ω at 100 MHz, 1206, WE-CBF SMD, 
EMI suppression ferrite 

Wurth 742792141 Wurth 742792141 

L3 10 µH, inductor, shielded power, XAL40 
series 

Coilcraft XAL4040-103ME XAL4040-103ME 

L4 2.2 µH, inductor, shielded power, XAL40 
series 

Coilcraft XAL4020-222MEB Coilcraft XAL4020-
222MEB 

https://www.analog.com/ADA4940-1?doc=UG-1042.pdf
https://www.analog.com/ADA4940-1?doc=UG-1042.pdf
https://www.analog.com/ADP2370?doc=UG-1042.pdf
https://www.analog.com/ADP2370?doc=UG-1042.pdf
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Reference Designator Description Manufacturer Part Number Stock Code 

LED1 LED, SMD, green OSRAM LGQ971 Digi-Key 475-1409-1-ND 

R1 2.4 kΩ, 0.063 W, 1%, 0603 resistor Multicomp MC0063W060312K4 FEC 9330879 

R2 100 kΩ, 0.1 W, 1%, 0805 resistor Multicomp MC01W08051100K FEC 9332405 

R3, R11, R12, R13, R14, R20, R21, 
R23, R25, R36, R38, R40, R42, 
R44, R46, R48, R50, R51, R52, 
R53, R59, R66, R68, R69, R73, 
R74, R75, R77, R78, R79, R85, 
R86, R90, R91, R95, R96, R99, 
R100 

0 Ω, SMD resistor Multicomp MC 0.063W 0603 0R FEC 9331662 

R4, R5, R8, R9 1 kΩ, 0.063 W, 1%, 0603 resistor Multicomp MC0063W060311K FEC 9330380 

R7 88.7 kΩ, 1%, 0805 resistor Vishay Draloric CRCW080588K7FKEA FEC 2139026 

R10 1%, 0805 resistor Multicomp MC01W08050R FEC 9333681 

R17, R22, R32, R37 49.9 Ω, 0.1 W, 0.1%, 0805 resistor Panasonic RN73C2A49R9BTG FEC 1140694 

R24, R41 200 Ω, 0.1 W, 1%, 0805 resistor Multicomp MC01W08051200R FEC 9332758 

R27, R28, R34, R35 Thick film, chip, resistor Vishay Draloric CRCW0805590RFKEA FEC 1653021 

R45, R65, R67 10 kΩ, 0.1 W, 1%, 0805 resistor Multicomp MC01W0805110K FEC 9332391 

R93 20 kΩ, 0.063 W, 1%, 0603 resistor Multicomp MC0063W0603120K FEC 9330771 

R6, R15, R16, R18, R19, R26, 
R29, R30, R31, R33, R39, R43, 
R49, R54, R55, R56, R57, R58, 
R60, R70, R71, R72, R76, R80, 
R84, R87, R88, R89, R92, R94, 
R97, R98, R101 

SMD resistor, 0603 Not applicable Not applicable Do not place 

J2, J3 3-pin terminal block (5 mm pitch) CamdenBoss CTB5000/3 FEC 151790 

J5 160-pin, 10 mm male, VITA 57 connector Samtec ASP-134604-01 Samtec ASP-134604-01 

J6, J10 Connector, jack end launch PC gold SMA Emerson 142-0701-851 Digikey J658-ND 

J8 7-way, SSW, 2.54 mm, vertical socket Samtec SSW-107-01-T-S FEC 1803478 

J9 7-way, SIP, 2.54 mm, TH header Samtec TLW-107-05-G-S FEC 1668499 

Table 7. Evaluation Board Models 

Product Ordering Model 

Maximum 
Throughput 
(MSPS) Input Type 

Sample Rate 
(MSPS) Resolution (Bits) 

Package Used on 
Evaluation Board 

AD4000BRMZ EVAL-AD4000FMCZ 2 Pseudo differential 2 16 10-lead MSOP 

AD4001BRMZ EVAL-AD4001FMCZ 2 Fully differential 2 16 10-lead MSOP 

AD4002BRMZ EVAL-AD4002FMCZ 2 Pseudo differential 2 18 10-lead MSOP 

AD4003BRMZ EVAL-AD4003FMCZ 2 Fully differential 2 18 10-lead MSOP 

AD4020BRMZ EVAL-AD4020FMCZ 1 Fully differential 1.8 20 10-lead MSOP 
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NOTES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

I2C refers to a communications protocol originally developed by Philips Semiconductors (now NXP Semiconductors). 

 

ESD Caution  
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection 
circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality. 

Legal Terms and Conditions 
By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions 
set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you 
have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement.  This Agreement is made by and between you (“Customer”) and Analog Devices, Inc. 
(“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal, 
temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided 
for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional 
limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board. As used herein, the term 
“Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including 
ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may 
not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to 
promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any 
occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board. 
Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written 
notice to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO 
WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, 
RELATED TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF 
INTELLECTUAL PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S 
POSSESSION OR USE OF THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES 
SHALL BE LIMITED TO THE AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will 
comply with all applicable United States federal laws and regulations relating to exports. GOVERNING  LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the 
Commonwealth of Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and 
Customer hereby submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is 
expressly disclaimed. 

©2016–2019 Analog Devices, Inc. All rights reserved. Trademarks and  
 registered trademarks are the property of their respective owners. 
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